
Computer-Lab Instruction Software



At SMART, we’re always improving our customers’ experience by 
offering software upgrades, patches and product news. Register your 
copy of SynchronEyes software to be notified of these announcements 
in the future.

We also want to give you the best technical support possible. 
Please help us by registering your SynchronEyes software and keeping 
this information available:

:

:

Register online at www.smarttech.com/products/registration

Serial Number

Date of Purchase

Trademark Notice

Copyright Notice

SynchronEyes is a registered trademark of SMART Technologies Inc. in Canada. SynchronEyes and SMART Board are 
trademarks of SMART Technologies Inc. Microsoft and Windows are registered trademarks of Microsoft Corporation in 
the U.S. and/or other countries. Adobe is a registered trademark of Adobe Systems Incorporated in the U.S. and/or 
other countries. All other third-party product and company names are mentioned for identification purposes only and 
may be trademarks of their respective owners. 

The use and copying of SynchronEyes software is subject to a license agreement. Any other use is prohibited. No part 
of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into any 
language in any form by any means without the prior written consent of SMART Technologies Inc. Information in this 
manual is subject to change without notice and does not represent a commitment on the part of the vendor.

© 1999–2004 SMART Technologies Inc.  Printed in Canada 05/2004.All rights reserved.





Table of Contents

Welcome to SynchronEyes Software......................................................1
Optimal Display Settings and Network Configuration............................................ 2
Network Size and Speed Considerations .............................................................. 3

Installing SynchronEyes Software ..........................................................5
Ports Required for SynchronEyes Software .......................................................... 5
Teacher Installation ............................................................................................... 6
Student Installation Options................................................................................... 7
Reconfiguring Student Options after Installation ................................................... 9

The Teacher Interface.............................................................................11
The Views Toolbar............................................................................................... 11
Thumbnails View ................................................................................................. 12
Chat View ............................................................................................................ 12
Applications View ................................................................................................ 13
Quiz View ............................................................................................................ 13
File Transfer View................................................................................................ 14
The Students List................................................................................................. 14

Customizing the Teacher Interface .......................................................17
Creating Multiple Teacher IDs ............................................................................. 17
Organizing Students into Groups ........................................................................ 18
Changing Thumbnail Size ................................................................................... 21
Arranging Thumbnails ......................................................................................... 22
Changing Thumbnail Names ............................................................................... 23
Configuring the Pen Tool..................................................................................... 24
Refreshing Your Thumbnails View to Eliminate Disconnected Students ............ 26

Monitoring and Controlling Students ...................................................27
Monitoring the Class............................................................................................ 27
Windowed Vs. Full Screen Mode ........................................................................ 28
Controlling a Student Desktop............................................................................. 29
Annotating over a Student Desktop with the Pen Tool ........................................ 31
Locking Out Your Student(s) ............................................................................... 32
Table of Contents i



Changing the Lock-Out Message ....................................................................... 34
Blocking Internet Access .................................................................................... 35
Blocking Applications........................................................................................... 36
Adding Applications to the Applications List ........................................................ 39
Remotely Launching an Application on Student Computers ............................... 40
Capturing an Image of a Student’s Desktop........................................................ 41
Remotely Logging Off, Shutting Down or Restarting Student Computers........... 43
Shutting Down SynchronEyes Software on a Student Computer........................ 45
Controlling Student Disconnect ........................................................................... 45

Interacting with Students .......................................................................47
Viewing a Student’s Question.............................................................................. 47
Chatting with Students......................................................................................... 49
Controlling Student Chat ..................................................................................... 51
Sending Files to and Receiving Files from Students ........................................... 52
Specifying File Transfer Preferences .................................................................. 55
Polling Students................................................................................................... 56
Broadcasting Teacher and Student Desktops ..................................................... 58

Administering Electronic Quizzes.........................................................63
How SynchronEyes Software Facilitates Quizzes............................................... 63
Question Types ................................................................................................... 65
Sending Questions as Originally Ordered ........................................................... 70
Allowing Application Access During a Quiz ......................................................... 71
Withholding Grades ............................................................................................. 71
Creating a Quiz ................................................................................................... 72
Opening and Importing a Quiz............................................................................. 75
Editing a Quiz ...................................................................................................... 76
Previewing a Quiz................................................................................................ 78
Sending a Quiz to Students................................................................................. 78
Collecting Student Quizzes ................................................................................. 80
Importing a Quiz from Version 3.0 of SynchronEyes Software ........................... 80

The Student Interface .............................................................................81
Student System Tray Icons ................................................................................. 81

Using the Student Software...................................................................85
Opening the Student Software ........................................................................... 85
ii Table of Contents



Logging On to the Student Software ................................................................... 86
Connecting to a Different Teacher ID .................................................................. 88
Logging Off of SynchronEyes Student-Station Software..................................... 89
Joining and Withdrawing from a Group ............................................................... 89
Asking the Teacher a Question ........................................................................... 91
Casting a Vote ..................................................................................................... 91
Chatting with the Teacher and Other Students ................................................... 92
Completing a Quiz ............................................................................................... 93
Receiving Files from the Teacher........................................................................ 93
Sending Files to the Teacher............................................................................... 94

Customer Support .................................................................................95
Contacting SMART Technical Support................................................................ 95
General Inquiries ................................................................................................. 95
Registration ......................................................................................................... 95
Sending Feedback............................................................................................... 96
Obtaining More Information for Your Product...................................................... 96

Appendix: License Agreement ..............................................................97
License Agreement for SynchronEyes Software ................................................. 97

Index.......................................................................................................101
Table of Contents iii



iv Table of Contents



Welcome to SynchronEyes® Software

You’re about to make the job of monitoring and controlling students in a computer lab more 
efficient and even more rewarding as well. Get the most from SynchronEyes software by 
taking a moment to review the following summary of features.

With SynchronEyes computer-lab instruction software, you can use your current network to 
monitor and control your students’ computers. Double-click on a student’s thumbnail screen 
and a full-screen version of the desktop appears, allowing you to monitor their activity in 
detail. Take control of students’ desktops and show them a better way to do their work – or 
show the whole class by broadcasting the desktop.

SynchronEyes software lets you chat with students, prepare and deliver an interactive quiz, 
respond to student questions, transfer data, video and audio files to students, and conduct a 
class poll – all without moving an inch from your own computer.

You’ll create a more focused learning environment for your class, one that enhances the 
effectiveness of computer technology as a teaching tool while minimizing its potential for 
distraction. With the click of a button, you can disable all (or selected) mice and keyboards 
in the classroom and inform students that their attention is required at the front of the class. 
Keep your students on track by blocking access to both the Internet and specific 
applications. You can also remotely launch any application that’s installed on student 
computers, so the entire class (or a group) can sit down to the same open application.

Brought to you by SMART Technologies, SynchronEyes software takes advantage of 
SMART Board interactive whiteboard features. When using SynchronEyes software on an 
interactive whiteboard, you can use a pen tray stylus to write over top of any desktop you’re 
broadcasting, and students can see your annotations on their own monitors as well. 

Monitor, Control and Broadcast

Deliver Information Efficiently

Focus Your Students’ Minds

Integrate SynchronEyes with Your SMART Board™ Interactive Whiteboard
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However, you don’t need a SMART Board interactive whiteboard to annotate over the 
screen you’re broadcasting, because annotation capability is built right into SynchronEyes 
software. When broadcasting from your workstation, you can click the Pen button and write 
with your mouse over top of the image, and students can view the annotations on their 
monitors.

Optimal Display Settings and Network Configuration
SynchronEyes software works best when the teacher and student computers are set to the 
same screen resolution and color depth. However, the software can make adjustments for 
different color settings or resolutions. For example, if a broadcasting station (either teacher 
or student) is running at a higher resolution than a viewing station, scroll bars appear on the 
viewing station, so you can view the entire higher-resolution screen.

Similarly, if a broadcasting station has a higher color setting than a viewing station, that 
broadcasting station’s colors are reduced so you can see it at the viewing station. For 
example, if a student’s computer has a higher color setting than your machine, you’ll see a 
“Color Reduced” message below the thumbnail, and, when you click on that thumbnail to 
view a live, full-screen version, the colors appear slightly degraded.

By setting all the computers to the same display settings, you can avoid using scroll bars or 
viewing degraded colors.

1. Click the Start button on the taskbar, and select Settings > Control Panel.

2. Double-click Display. 

The Display Properties dialog box opens.

3. Click the Settings tab.

4. Under Colors or Color Palette, select a new color setting from the list. 

5. Under Screen Area or Desktop Area, drag the slider to select a new resolution.

1. Click the Start button on the taskbar, and select Control Panel.

To change the display settings of your monitor 
(Windows® 98/2000/Windows NT® operating system)

To change the display settings of your monitor
(Windows XP operating system)
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2. Click Appearance and Themes. 

3. Click Change the Screen Resolution. 

4. Select the Settings tab.

5. Under Color Quality, select a new color setting from the list. Under Screen resolution, 
drag the slider for a new resolution.

For enhanced speed and program performance, set your display to High Color (16-bit 
color). Refer to the chart below for the optimal color depth/screen resolution settings for 
your monitor.

Network Size and Speed Considerations
The preferred TCP/IP network configuration for SynchronEyes software is a switched or 
switching hub, which isolates network traffic to a particular segment of your local area 
network. With this configuration, your system is not affected by other network traffic, and the 
entire network isn’t slowed down because of SynchronEyes software activity. Of course, the 
smaller the number of connected students, the faster the activity.

Recommended Color Depth/Screen Resolution Settings

Color Depth/
Screen Resolution

256 Color
(8-bit)

High Color 
(16-bit)

True Color
(24-bit)

True Color 
(32-bit)

640 x 480 optimal optimal optimal optimal

800 x 600 optimal optimal optimal optimal

1024 x 768 optimal optimal optimal optimal

1152 x 864 optimal acceptable acceptable acceptable

1280 x 1024 optimal acceptable not recommended not recommended

1600 x 1200 optimal not recommended not recommended not recommended

TIP If your students have graphics-rich backgrounds on their desktops 
SynchronEyes software performance can be slowed down. To optimize 
performance, we recommend that student computers have simple, 
single-color desktop backgrounds.
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Use the following chart to determine the appropriate number of student stations for your 
network setup.

10 MB Network 100 MB Network
Up to 40 students Up to 80 students
4 Welcome to SynchronEyes® Software



Installing SynchronEyes Software

Before you install SynchronEyes software, make sure there isn’t an active Internet 
connection firewall on the computer. If you’re using the Windows XP operating system, for 
example, do not activate the Internet Connection Firewall in your computer’s Local Area 
Connection options. If this firewall is active, the teacher and students will be unable to make 
a connection in SynchronEyes software. 

Prior to installing SynchronEyes software on an Windows XP operating system, you may 
want to ensure the Internet Connection Firewall has not been activated, as shown below.

1. Select Control Panel > Network Connection > Local Area Connection.

The Local Area Connection Status dialog box appears.

2. Click the General tab and then click the Properties button.

The Local Area Connection Properties dialog box appears.

3. Click the Advanced tab.

4. Ensure that the check box beside Protect my computer and network by limiting or 
preventing access to this computer from the Internet is not selected.

Ports Required for SynchronEyes Software
Although it’s not recommend that you install SynchronEyes software on a computer with an 
active Internet connection firewall, this may be unavoidable. Therefore, although firewall 
configuration instructions are outside of the scope of the current manual, the table that 
follows tell you which communications ports must be available for SynchronEyes software 
to use.

IMPORTANT
Do not activate an Internet connection firewall on your computer. This will 
obstruct the teacher/student connection and make SynchronEyes software 
unusable.

To ensure the Windows XP Internet Connection Firewall isn’t active
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Ports Used by SynchronEyes Software (Version 5.0)

If you’re upgrading from previous versions of SynchronEyes software, you may need to 
open the ports listed in the following table.

         Ports Used by Previous Versions of SynchronEyes Software

Teacher Installation
The SynchronEyes software CD-ROM contains both the teacher and student software. 
Install the teacher software first. 

Either during the installation or when you first start the program, you must provide a 
Teacher ID to represent your computer on the network. You can use any name you like, 
provided it uniquely identifies you. For example, your Teacher ID could be your name, the 
name of the course or even the classroom location. You’ll need to provide your students 
with this name if they’re permitted to log in to the program. 

For more information about Teacher IDs, see “Creating Multiple Teacher IDs” on page 17.

1. Insert the SynchronEyes CD-ROM into your CD-ROM drive.

Port Purpose
5460 (TCP) Main communications port

5496 (UDP) Teacher discovery port

5491 (UDP) Broadcast port

5493 (UDP) Broadcast recovery port

Port SynchronEyes Version
5492 (TCP) Any version prior to 3.0

5494 (TCP) 3.0

5497 (TCP) 3.01 to 4.0

5460 (TCP) 4.1 to 5.0

To install SynchronEyes teacher-station software
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2. For most systems, the CD-ROM is self-starting. If you don’t have the AutoPlay feature 
activated, click Start > Run.

3. In your CD-ROM folder, browse to SynchronEyes > SynchronEyes Teacher, and 
open the Setup.exe file in your CD-ROM drive folder. 

4. Follow the on-screen instructions. 

When you install SynchronEyes teacher-station software, the Quiz Wizard is automatically 
installed. The Quiz Wizard helps you create the interactive quizzes that you distribute to 
student computers via the Quiz view of SynchronEyes teacher-station software. For those 
who like to create quizzes at home, you can take the SynchronEyes software CD-ROM 
home and install the Quiz Wizard on your home computer as a stand-alone application.

1. Insert the SynchronEyes software CD-ROM into the CD-ROM drive.

2. For most systems, the CD-ROM is self-starting. If you don’t have the AutoPlay feature 
activated, click Start > Run.

3. In your CD-ROM folder, browse to SynchronEyes > SynchronEyes Quiz Wizard 
folder, and open the Setup.exe file in your CD-ROM drive folder.

4. Follow the on-screen instructions.

Student Installation Options
When you install SynchronEyes student-station software, you can accept the default 
settings or configure customized student settings. 

The default settings are:

• the student interface is visible

• the student program starts automatically when Windows starts

• students are allowed to browse for and connect to the teacher, chat, submit files and 
ask questions

• the computer user account is used for the student name

• files you send to the students are stored in C:\My Documents\Shared Files

If you decide to configure customized student settings, you can choose:

To install SynchronEyes Quiz Wizard on a home computer
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• whether the software will run in visible or hidden mode on the student computer (see 
“Installing the Student Software in Hidden Mode” on page 8) and whether it will start 
automatically

• whether students will be automatically connected to the same Teacher ID when they 
start SynchronEyes software

• whether students are allowed to chat, submit files to their teacher or ask questions

• what the student name will be (e.g., the default machine name, computer user account, 
a name the student chooses or a name you choose)

• to navigate to a custom folder for storing your sent files rather than the default folder 
(C:\My Documents\Shared Files). Make sure your students have permission to 
access the folder you specify here.

If you accept the default installation of the Student Configuration Wizard, the choices you 
make during the student installation are not fixed permanently. You can reconfigure any or 
all of these options at any time by running StudentConfig.exe (see “Reconfiguring the 
Student Options after Installation” on page 9 for more information).

You can install SynchronEyes software on student computers in either hidden or visible 
mode. As its name suggests, hidden mode lets you observe computer activity in your lab 
surreptitiously. In this mode, there’s no visual indication on the student interface that 
monitoring software is running. Your students will only become aware of the software if you 
initiate a quiz or a poll, broadcast a desktop, or lock their computers. 

In hidden mode, SynchronEyes software starts automatically (and completely in the 
background) when a student logs on to a computer. Therefore, you must supply the 
following setup information when you install the software on a student computer:

• Student Login name: By default this will be the Windows login name associated with the 
student machine. However, you can specify any name you prefer. 

• Teacher ID: Enter or select the name you’ve chosen to identify yourself.

After installation, these identifiers are derived from the SynchronEyes configuration file 
(SynchronEyesClient.ini) each time a student logs in to the computer, and connection will 
take place automatically without the student’s knowledge.

Installing the Student Software in Hidden Mode
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.

1. Insert the SynchronEyes Software CD-ROM into the CD-ROM drive of the student 
computer.

2. Navigate to the SynchronEyes Student directory and double-click 
SynchronEyesClient.exe.

3. Follow the on-screen instructions. 

4. Repeat steps 1–3 on other student computers.

Reconfiguring Student Options after Installation
To reconfigure student options after installation, you must install the Student Configuration 
Wizard during initial Student installation. With the wizard installed, it’s easy to change any or 
all student installation options any time.

1. Navigate to the SynchronEyes Student folder (in the Program Files directory of the 
student computer).

2. Double-click StudentConfig.exe.

3. Follow the instructions in the SynchronEyes Student Configuration Wizard to select and 
configure the options you want.

4. Click the Finish button.

To install SynchronEyes student-station software

TIP To configure the other student computers identically to the first student 
computer (without having to select all the same options with each 
installation), copy the SynchronEyesClient.ini file in the SynchronEyes 
Student folder of the computer where you just installed the software, and 
paste it into the same folder on other student computers.

To reconfigure student options after installation
Installing SynchronEyes Software 9



10 Installing SynchronEyes Software



The Teacher Interface

SynchronEyes teacher-station software offers five functionally distinct views:

• Thumbnails view – see thumbnail images of each student’s display and broadcast your 
screen or a student’s screen to all student monitors

• Chat view – chat with students, and then view and save all chat dialogue

• Applications view – block or remotely launch selected applications 

• File Transfer view – organize the files you want to send, send these files to your 
students, and open files sent to you by students

• Quiz view – create, edit, distribute, collect and view the results of interactive quizzes

The Views Toolbar

The Views toolbar is available in all views, on the left side of the SynchronEyes interface. 

Click to observe thumbnails of each student’s display 
screen, broadcast to or control a student desktop

Click to chat with a student or students

Click to transfer files to students and open files 
received from students

Click to create, distribute, collect and view the tallied 
results of interactive quizzes

Click to block one or more selected applications or remotely 
launch an application
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The core functions of SynchronEyes Teacher – managing student groups, locking students 
away from their desktops, responding to student questions, blocking Internet access and 
polling students – can all be performed from any of the five views. A summary of the 
functions that are specific to each view are presented in the next few pages.

Thumbnails View
When you start SynchronEyes software, you’ll see miniature images (thumbnails) of your 
connected students’ active desktops. These thumbnails change in real time (though slightly 
delayed) with every instance of student input. This is very likely the view you’ll use most 
often when SynchronEyes software is open at your desktop.

The size of each thumbnail is determined by the size of the teacher’s desktop, as well as the 
Thumbnail Size setting in the View menu. You can choose between Very Large, Large, 
Medium, Small and Very Small (see “Changing Thumbnail Size” on page 21). These 
settings result in two, three, four and five columns of thumbnails respectively (the higher the 
number of columns, the smaller the thumbnail). You can arrange the thumbnails 
alphabetically or in a customized arrangement of your choice (see “Arranging Thumbnails” 
on page 22).

You can perform many instructional and control activities in this view. Specifically, you can:

• monitor classroom activity as it occurs

• assume mouse and keyboard control of a student desktop 

• broadcast your screen or a student’s screen to the class 

• lock out the desktop of an individual student

• log off, shut down, or restart every computer in the class or the computer of a selected 
student

• capture an image of a selected student’s desktop

• rearrange student thumbnails to reflect the actual seating plan in the classroom 

Chat View
In Chat view you can:

• initiate and participate in chat sessions with the entire class, a group of students or 
selected students. 
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• initiate a private chat session with one or more students

• control your students’ ability to chat among themselves (the default is that the students 
are unable to chat)

• save a copy of a chat session as a text file

Applications View
The Applications view gives you complete control over which applications your students can 
use at any given time. For example, if you’re administering an exam, you may want to block 
the use of all applications except for the SynchronEyes Quiz Wizard application. This 
prevents students from accessing information that would give them an unfair advantage 
during an exam. Similarly, if you want your students to focus narrowly on an assignment, 
you may want to block the use of all applications except those that are necessary for that 
assignment.

Another very useful feature of this view is the ability to launch an application on student 
computers, ensuring the entire class (or group) is at the same starting point for a 
demonstration or discussion.

Quiz View
Use the Quiz Wizard quiz template to create anything from a pop quiz with a handful of 
questions to a lengthy final exam with many multiple-choice, ordering and matching 
questions. The Quiz Wizard appears automatically when you click the Create Quiz button in 
Quiz view. A link to every quiz you create in the Quiz Wizard (with the current Teacher ID) 
appears in a list in Quiz view. Click on the link to see a preview of the quiz as it will appear 
to students; double-click on the link to open the quiz in the Quiz Wizard and revise it.

NOTE: You can also install the Quiz Wizard separately from SynchronEyes teacher-station 
software on your home computer. This lets you prepare quizzes at home, if you prefer.

When you finish creating or editing a quiz, you can preview it and then distribute it to your 
students with the click of a button. The quiz opens on student desktops over their current 
active application. To complete the quiz, students select their responses and click the 
Submit to Teacher button when they’re finished. You’ll see the responses in tallied form in 
Quiz view, together with a class average. If you prefer, you can instantly collect all student 
quizzes with the End Quiz button. 
The Teacher Interface 13



File Transfer View
Use this view to transfer both data and multimedia files to all students, a group of students 
or selected students. This view is divided into:

• a Files Sent section, which lists the files you’ve sent to students 

• a Files Received section, which lists the files you’ve received from students

Both sections of the view also list the names of students who have received the file, the 
proportion of the file that has been transmitted, the size of the file and its full network path.

You can specify where the files you send to students are stored when you install 
SynchronEyes software or after (by running the Studentconfig.exe file in the SynchronEyes 
Student program directory). 

NOTE: If you have a number of students accessing the same computer throughout the day, 
they will all use the same Received file folder. 

By default, all the files sent by your students are stored in C:\My Documents\Submitted 
Student Files. You can easily change the default folder by selecting Preferences from the 
Options menu (see page 55 for complete instructions). Of course, you don’t need to 
navigate to the storage folder to view the files; you can open all files you receive from 
students right in the File Transfer view.

The Students List
The Students list appears on the right side of all views except the Thumbnails view. This list 
includes the names of all students who are members of the selected group and their current 
status.

Destination of Sent Files

Destination of Received Files
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The Students List

In the Students list, the current status of each student is represented by an icon next to the 
student name. When more than one status icon applies to a single student (for example, a 
student may be connected and asking a question at the same time), the icon of greatest 
importance is displayed. For example, since the question state is more important than the 
connection state, the question icon appears next to the name of the student with the 
question. The icons are shown below in order of priority from most to least important:

Student Status Icons

Icon Status
Student has disconnected (most important state)

Student is locked out

Student is completing a quiz

Student has yet to respond to a vote

Student has responded affirmatively to a vote

Student has responded negatively to a vote

Student has a question

Student is blocked from using selected applications

Student is blocked from accessing the Internet

Student is connected (least important state)
The Teacher Interface 15
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Customizing the Teacher Interface

You can customize the teacher interface to suit your needs. In this section, you’ll learn how 
to:

• create multiple Teacher IDs (this page)

• organize your students into groups (page 18)

• change the size of the student thumbnails (page 21)

• rearrange thumbnails (page 22)

• change the name under a thumbnail (page 23)

• reconfigure the pen tool (page 24)

• refresh the Student list (page 26)

Creating Multiple Teacher IDs
Every class is unique. You may teach physics to Grade 11 students in the morning and to 
Grade 12 students in the afternoon. The only similarity between these two classes may be 
the subject and the room in which the classes are taught. Everything else may be very 
different, from the students who attend and the quizzes they write, to the groups and the 
seating plan you create.

To help you stay organized for your different classes, SynchronEyes software lets you 
create a different Teacher ID for each class, and each Teacher ID is associated with a 
unique profile of settings, student groups and quizzes. This profile is stored with the 
Teacher ID and made available to you each time you select that ID. 

Teacher IDs are stored in the Teacher ID list in the Teacher ID dialog box (accessed by 
selecting Change Teacher ID from the File menu). This list contains the last ten Teacher 
IDs you used. If a Teacher ID drops off this list through lack of use, just type the Teacher ID 
into the text box to access it.

SynchronEyes teacher-station software always opens to the last Teacher ID used. Similarly, 
when your students start the student software, the software always attempts to connect with 
the last active Teacher ID associated with the Student login name.
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1. Start SynchronEyes teacher-station software.

2. Select Change Teacher ID from the File menu.

The Teacher ID dialog box appears, displaying your current Teacher ID (if you have 
one). 

3. In the Teacher ID box, type a new Teacher ID.

4. Click OK.

NOTES:

The Teacher ID cannot exceed 36 characters in length.

Your students receive a message on their monitor when the Teacher ID changes, 
asking if they want to switch to this teacher. They should click the Yes button to connect 
to the new Teacher ID.

Organizing Students into Groups
SynchronEyes teacher-station software lets you divide your students into groups (up to a 
maximum of 10) with very little effort. While you can allow students to join or withdraw from 
a group on their own, only you can create a group.

With your students in groups, you can interact with the class more meaningfully by:

• creating tailor-made quizzes for individual groups 

• locking out a group (rather than the entire class). If one group abuses its computer 
privileges, you don’t need to punish everyone.

To create a new Teacher ID
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• writing group-focused chat text or broadcasting your screen to a group without 
distracting students who are working in unrelated areas

• polling groups about issues relevant to them

• focusing your efforts on those groups that most require attention

At the top of each view, there is a tab for each group you’ve created, and the Students list 
on the right includes the names of all group members.

1. Click the Groups button. 

To create a group

List of students in the 
Tennyson group

Group Tabs

Students who are members of the 
selected group (Students list)
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The Groups dialog box appears.

2. Click the New button. 

The New Group dialog box appears.

3. In the Group name box, type a name that identifies this group of students.

4. To give students the ability to join or withdraw from this group, select Allow students to 
join this group on their own.

NOTE: By default, only the teacher can add or remove students from groups.

5. Click OK, and then click OK again. 

The group appears as a new tab.

1. Click the Groups button. 

2. Select the group you want to delete.

3. Click the Remove button.

To delete a group
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4. Click OK.

1. Click the Groups button. 

2. Select a group from the student groups list.

3. Click the Edit button. 

The Edit Group dialog box appears.

4. Select a student. 

OR

Select multiple students.

5. Click the Add button to add student(s) to the group.

OR

Click the Remove button to remove student(s) from the group.

6. Click OK.

Changing Thumbnail Size
Depending on your monitor resolution, you may be able to see all the student thumbnails on 
your screen without scrolling. However, if scroll bars appear in the Thumbnails view – and 
you prefer not to alter your monitor’s resolution – you can change the size of the thumbnails 
to avoid scrolling.

By default, the thumbnails are sized according to the Best Fit view, a variable view that 
shows an optimal number of thumbnails, taking into account the size of your maximized 
window and the number of students currently connected. Best fit is recalculated as the 
number of connected students changes, and the size of the thumbnails changes 
automatically. For example, if thirty students are connected, the thumbnails are small. If 
only two students are connected, the thumbnails are much larger.

NOTE: Although you can see more student thumbnails without having to scroll, it’s more 
difficult to view student activity in detail as the thumbnails diminish in size. 

To add or remove students from a group
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1. Click the Thumbnails button in the Views toolbar.

2. Select Thumbnail Size from the View menu.

3. Select one of the five sizes available: Very Large (two thumbnails across), Large (three 
thumbnails), Medium (four thumbnails), Small (five thumbnails), and Very Small (six 
thumbnails). 

OR

Select Best Fit for thumbnail sizes that change according to the number of students 
currently connected.

Arranging Thumbnails
By default, student thumbnails are arranged alphabetically in Thumbnails view, though you 
can rearrange them in any way you like. For example, you might want to arrange the 
thumbnails to reflect the seating plan of the room. 

The new thumbnail arrangement is saved and remains in effect in subsequent sessions. If 
you’re not happy with the new arrangement, it’s easy to return to an alphabetically arranged 
thumbnail grouping.

1. Select the tab of the group you want to arrange alphabetically.

OR

Select the All Students tab.

2. Select View > Thumbnail Arrangement > Alphabetical Ordering.

The thumbnails are rearranged in alphabetical order starting in the upper left corner. 
Any new students joining the group are inserted into the list in alphabetical order. This 
arrangement remains in effect for subsequent sessions. 

1. Select the tab of the group you want to rearrange.

OR

To change the thumbnail size

To arrange the thumbnails alphabetically (default)

To customize the thumbnail arrangement
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Select the All Students tab.

2. Select View > Thumbnail Arrangement > Custom Ordering.

3. Drag the thumbnails vertically or horizontally to a new location.

Any new group members will be appended to the end of the list. This arrangement 
remains in effect for subsequent sessions.

Changing Thumbnail Names
You can easily change the name under a thumbnail. However, If you enter a specific name 
while installing or reconfiguring the student software, the thumbnail will revert to that name 
whenever you start SynchronEyes software.

For example, if you entered “Student 6” as a student computer name when you installed the 
student software, and then you changed that name in the Thumbnails view to “George”, the 
thumbnail name will revert to “Student 6” the next time you open SynchronEyes software. 
To permanently change the thumbnail name, you must reconfigure the name option in the 
Student Configuration Wizard (page 9).

1. Click the Thumbnails button on the Views toolbar.

2. Click on a name below a thumbnail.

The name will appear in a text edit box.

To change the thumbnail name (for the current session only)
Customizing the Teacher Interface 23



3. Type a new name.

NOTE: You must have the Student Configuration Wizard installed on the student machine 
to perform the following reconfiguration procedure.

1. On the student computer you want to rename, navigate to the C:\Program 
Files\SynchronEyes Student folder and open StudentConfig.exe.

2. Click Next until you reach the Student Name window.

3. Click the bottom selection and type in a new name.

4. Click Next until you reach the final window, and click OK.

The next time you start SynchronEyes teacher-station software, the associated 
thumbnail has the name you specified.

Configuring the Pen Tool
If you use SynchronEyes software on a SMART Board interactive whiteboard, you can write 
over top of any projected desktop and your annotations will be displayed on the screens of 
all connected students. This is great way to direct your students’ attention and write 
instructional notes.

Even if you’re not using an interactive whiteboard, you can still write over any application 
with electronic ink. When you open a student’s desktop on your monitor, or when you 
broadcast a desktop, a toolbar appears that contains a pen button. Click this button, and 
then click and drag your mouse to write on the screen.

You can change the electronic ink to a different width and color or make it resemble 
highlighter ink (a transparent appearance).

1. Select Preferences from the Options menu.

To change the thumbnail name (for future sessions)

To change the appearance of the Pen Tool ink
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The Preference Settings dialog appears.

2. Click the Annotation Pen tab.

3. To change the width of the electronic-ink stream, type or select a new width in the 
Width box. You can choose between 1 and 32 pixels.

4. To change the ink color, click once on the color box, click the Color button, click a color 
swatch, and then click OK.

5. To make the ink transparent (highlighter effect), click the Highlighter check box.

6. Click OK to activate these settings.
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Refreshing Your Thumbnails View to Eliminate Disconnected 
Students
If you allow students to disconnect, your Thumbnails view may be cluttered with the desktop 
images of students who are no longer connected to SynchronEyes software. A 
disconnected student is represented as a desktop thumbnail with a superimposed red X.

These inactive thumbnails occupy valuable screen real estate. By refreshing your view, you 
make more room available on your monitor for active thumbnails; you’ll scroll less and be 
able to see more thumbnail detail. 

Select Refresh from the View menu.

All inactive SynchronEyes software connections (thumbnails with red crosses) disappear.

To refresh your Thumbnails view
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Monitoring and Controlling Students

In this section, you’ll learn how to:

• monitor the class (this page)

• monitor in windowed or full-screen mode (page 28)

• control a student desktop (page 29)

• annotate over a student desktop (page 31)

• lock out all students or a single student (page 32)

• change the lock-out message (page 34)

• block Internet access (page 35)

• block specific applications (page 36)

• remotely launch an application on students’ computers (page 40)

• capture a student desktop (page 41)

• disconnect an individual student (page 45)

• control student disconnect (page 45) 

Monitoring the Class
In the Thumbnails view, you can watch live thumbnail images of every student’s desktop 
activity, ensuring at a glance that everyone is focused on the assigned task. For a closer 
look, double-click a thumbnail image to see that student desktop in full-screen mode. 

1. Click the Thumbnails button on the Views toolbar. 

Thumbnails of all connected student desktops appear.

2. For a full-screen mode of any thumbnail, double-click on the image.

OR

Click the thumbnail, and then click the Observe button.

To monitor the class
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NOTE: If the student’s desktop resolution is lower than yours, the thumbnail will be 
centered in the middle of your display, with a black border. If the student’s screen 
resolution is higher, scroll bars appear around the image.

The Student’s Desktop toolbar appears with the student’s name in the title bar. This 
toolbar lets you capture a bitmap of the student’s current desktop, assume control of the 
desktop, view the desktop in windowed mode and use the pen tools to annotate over 
the desktop. You can drag this toolbar to any location.

3. To return to the Thumbnails view, click the Close button in the toolbar.

OR

Click the Menu button and select Stop Observing.

Windowed Vs. Full Screen Mode
When you double-click on a thumbnail to enlarge the view, the desktop fills your screen by 
default. However, you may prefer to view the student desktop in a resizable window while 
keeping the Thumbnails view of SynchronEyes software open at the same time. This 
arrangement lets you keep one eye on a single student’s desktop while monitoring the other 
student thumbnails. 

Using Windowed Mode to Monitor a Student

Click to return to the 
Thumbnails view

Thumbnails 
View

Individual 
Student 
Desktop
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1. Double-click the student thumbnail.

OR

Select the student thumbnail and click the Observe button in the toolbar.

A floating toolbar appears near the top of the window.

2. Click the Menu button in the floating toolbar.

3. Select View in Windowed Mode.

The thumbnail appears in a resizable window, and the Thumbnails View window 
appears behind it. 

NOTE: To return to Full Screen mode, press the Full Screen button in the toolbar.

Controlling a Student Desktop
Double-click any thumbnail to open that student’s desktop on your monitor or a SMART 
Board interactive whiteboard. When you click the Control button in the toolbar, you can use 
your mouse to assist individual students without leaving your desk. 

To view a student desktop in Windowed Mode
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By default, student input is blocked and you have exclusive control of the student desktop. 
While you can alter this so that you and the student can share control, if you and the student 
are attempting to control the mouse or keyboard at the same time, you will always take 
precedence. 

1. Select Preferences from the Options menu.

The Preference Settings dialog appears.

2. Click the Control tab.

3. Click Shared and click OK.

4. Click a thumbnail.

5. Click the Control button in the toolbar.

The student’s desktop opens on your screen. 

6. Control the student application as if it were your own. For example, add information to 
the studen’s active application via your own keyboard or scroll to another page.

The students see your actions on their own monitors, and can actively share mouse and 
keyboard control with you, providing instant feedback to your changes and suggestions. 
However, when both you and the student try to use the mouse at the same time, you 
always “win.”

7. Broadcast a demonstration to the class using this student’s desktop (as described on 
page 58).

OR

Return to the Thumbnails view by clicking the Stop button (in windowed mode) or 
selecting Stop Broadcasting from the Menu button in the Student Desktop toolbar (in 
full screen mode). 

To share control of a student’s desktop
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Annotating over a Student Desktop with the Pen Tool
While observing or controlling a student desktop, you can write over the student’s desktop 
(or any application the student is running) by clicking the Pen button in the toolbar and then 
clicking and dragging on the screen. The electronic ink that appears on your monitor also 
appears on the student’s monitor. Of course, if you’re running SynchronEyes software on a 
SMART Board interactive whiteboard, you can do the same using a stylus from the pen tray.

NOTE: For information on changing the color, width and transparency of the electronic ink, 
see “Configuring the Pen Tool” on page 24.

Using the Pen Button to Handwrite a Greeting

Click and drag to write 
with electronic ink
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However, the appearance of the ink is only temporary: When you press the Mouse button to 
return to mouse control, the electronic ink disappears, and the underlying application is 
unaffected by your annotations (on your computer and the student’s computer). 

1. Click the Pen button on the Desktop toolbar.

2. Click and drag to write over the student desktop.

3. To return to mouse control, click the Mouse button.

The electronic ink you created in step 2 disappears.

Locking Out Your Student(s)
You can get the attention of a distracted class by clicking the Lock button. This button locks 
the students’ mice and keyboards and presents them with a black screen displaying the 
message, “Eyes to the front, please.” 

Advise your students not to panic; their work is only temporarily interrupted, not lost. If you 
like, you can change the lock-out message as well as the text and background color (see 
“Changing the Lock-Out Message” on page 34). When you click the Lock button a second 
time, the students’ desktops are completely restored. 

In any view of SynchronEyes software, you can lock out one or more selected students, a 
single group or all students.

TIP Before you click the Mouse button and your annotation disappears, 
save it as a graphic file. Click the Screen Capture button to capture a 
snapshot of the annotation and background in any of a variety of graphic 
formats (see “Capturing an Image of a Student’s Desktop” on page 41).

To write over a student desktop with the Pen tool

Click here to return to mouse 
clicks (any electronic ink on the 
screen will disappear)
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1. To lock out all students, click the All Students tab.

OR

To lock out an single group, click a Group tab.

OR

To lock out selected students, click their names in the Students list. In the Thumbnails 
view, click on the individual thumbnails.

2. Click the Lock button.

In the Thumbnails view, a lock icon appears over each thumbnail.

In other views, lock icons appears beside locked-out students in the Students list.

On the student side, the lock-out message, “Eyes to the front, please,” is displayed on 
each student’s monitor. No amount of keyboard or mouse activity on a student's part will 
alter this visual and functional lock out (except on Windows NT, XP, and 2000, where 
CTRL + ALT + DEL brings up the Windows Task Manager).

NOTE: The students' work is only interrupted. No work is lost when the Lock button is 
clicked.

3. To restore the student desktops, click the Lock button again.

To lock out all students, a group of students, or selected students
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Changing the Lock-Out Message
The default lock-out message is “Eyes to the front, please”. However, you can change the 
lock-out message to any other text message you like. The altered lock-out message may be 
sent to the entire class, a single group of students or a single student.

1. Select Preferences from the Options menu.

2. Click the Lock Screen tab.

TIP A lock-out message is more attention-grabbing than a chat message, so 
consider using a customized lock-out message to direct a student who’s 
not focusing on their work. Change the lock-out message, click the Lock 
button once, and then, after the student has read your message, click it 
again to restore the student’s computer use. 

To change the default lock-out message
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3. Type your message in the Lock-out message text box.

4. To change the text color, click the Text button. To change the background color, click 
the Background button.

The Color dialog box appears.

5. Select a color or create a custom color.

6. Click OK.

Blocking Internet Access
With SynchronEyes software, you can Internet access for block all students, a student 
group, selected students or a single student. You can also block Internet access from any 
view of SynchronEyes teacher-station software.

The Internet block effectively renders the Microsoft Internet Explorer browser inoperable. 
When a blocked student clicks on their Internet Explorer browser, a page appears informing 
them that access to the Internet is restricted. Because this is a browser-specific block, any 
other browser (such as Netscape Navigator) will not be affected by it.

NOTE: This feature is not intended to replace Internet blocking applications that block 
students’ access to inappropriate sites. 

1. Select a student, several students, or a group of students. If you select neither 
individual students nor a group, the Internet browser block applies to all students.

NOTE: Multiple selection in SynchronEyes software is easy. Just click on the names 
you want to select. You don’t need to press the SHIFT or CTRL key on your keyboard.

2. Click the Internet Block button.

TIP
If your students use an Internet browser other than Microsoft Internet 
Explorer (such as Netscape Navigator), use the application blocking 
feature described on page 36 to block its use.

To block Internet access
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When the selected students try to activate their browser, the following message 
appears on their monitor:

3. To restore Internet browser use, click the Internet Block button again.

Blocking Applications
SynchronEyes software lets you restrict student access to specific applications in two ways. 
You can:

• Select restricted applications that you want to block. This option takes immediate effect. 
A student running a restricted application sees the application shut down almost 
immediately (and without warning), and they lose any unsaved work. 

• Select approved applications that you want students to access to the exclusion of all 
others. With this option, blocked applications that are already open are not shut down. 
Only newly opened applications are affected by the block, and students have the 
opportunity to save their work in an excluded program that is already running.

TIP
If you notice your students are running an inappropriate application, 
such as Microsoft Solitaire, put it in the restricted list and click the Block 
button. All open instances of Solitaire are shut down immediately.

TIP If you’ve assigned an in-class essay, you may want students to work 
exclusively in a word-processing application, such as Microsoft Word. 
Rather than specifying the applications you want blocked, just put Word 
on the Block all applications except list. This blocks every other 
application until the essay is completed. 
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You can create different lists of restricted applications for different groups. For example, for 
a group of students who consistently focus on their work and only occasionally access other 
applications, you may not want to block any applications. However, you may create an 
extensive list of blocked applications for a group of students who are frequently distracted.

You can select the applications you want to block in advance and then activate the block at 
an appropriate time: Applications are not actively blocked until you click the Block button in 
the toolbar. 

1. Click the Application button in the Views toolbar. 

The Applications view appears.

2. Click the All Students tab if you want the restriction to apply to the entire class. 

OR

Click a Group tab if you want the restriction to apply to a group of students.

OR

If you want the restriction to affect one or more individual students, select the student(s) 
in the Students list on the right side of the window.

3. Click Restrict the following applications.

4. Select one or more applications from the Applications list on the left side of the 
window.

NOTE: Multiple selection in SynchronEyes software is easy. Just click on the names 
you want to select. You don’t need to press the SHIFT or CTRL key. Click again on the 
selected item to clear the selection.

5. Click the Add button.

The application(s) appears in the restricted applications list on the right side of the 
window.

6. Click the Block button in the toolbar.

In a moment or two, any open instances of the application (in the group of students 
you’ve selected) shut down. A message appears indicating the SynchronEyes software 
has shut down the application, which the students must acknowledge by clicking the 
OK button.

To block one or more applications (including currently open instances)
Monitoring and Controlling Students 37



7. To restore access to the blocked application(s), click the Block button again.

1. Click the Application button in the Views toolbar. 

The Applications view appears.

2. Click the All Students tab If you want the restriction to apply to the entire class.

OR

Click a Group tab if you want the restriction to apply to a group of students.

OR

If you want the restriction to affect one or more individual students, select the student(s) 
in the Student list on the right side of the window.

3. Click Restrict all applications except.

4. Select one or more applications from the Applications list on the left side of the 
window.

NOTE: Multiple selection in SynchronEyes software is easy. Just click on the names 
you want to select. You don’t need to press the SHIFT or CTRL key. Click again on the 
selected item to clear the selection.

5. Click the Add button.

The application(s) appears in the approved applications list on the right side of the 
window.

6. Click the Block button in the toolbar.

Open instances of blocked applications are not shut down. Students can continue 
working and save their work. However, if a student attempts to open a new instance of 
a blocked application, a message appears indicating that SynchronEyes software has 
blocked access to the application. The student must acknowledge this message by 
clicking the OK button.

7. To restore access to the blocked application(s), click the Block button again.

To block all but approved applications
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1. Click the Application button in the Views toolbar. 

The Applications view appears.

2. Click the All Students tab or a Group tab.

3. Select one or more applications from the list of restricted/approved applications on the 
right side of the window.

NOTE: Multiple selection in SynchronEyes software is easy. Just click on the names 
you want to select. You don’t need to press the SHIFT or CTRL key. Click again on the 
selected item to clear the selection.

4. Select one or more applications from the Applications list on the left side of the 
window.

5. Click the Remove button.

The application immediately disappears from the restricted/approved list.

Adding Applications to the Applications List
The Applications view is dominated by a list of applications on the left side of the window, 
from which you can select applications to either block or to exclude from a general 
restriction. 

The applications on this list are those that have been fully installed on your hard drive and 
have changed the registry settings of your operating system. Therefore, there may be some 
applications listed here to which your students do not have access. There may also be 
applications you want to restrict that do not appear on this list. If you want to restrict or 
approve an application that is not on this list, click the New Application button. 

To remove applications from the restricted/approved list

TIP Game applications are probably among those applications you’ll want to 
block. If your students have access to the games installed with their 
Windows operating system, you’ll find the game executable files by 
navigating to C:\WINNT\System32 (in Windows 2000), 
C:\Windows\System (in Windows XP), or C:\Windows (in Windows 98). 
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1. Click the Application button in the Views toolbar. 

The Applications view appears.

2. Click the New Application button (located below the Applications list).

The Open dialog appears.

3. Browse to the .exe file and select it.

4. Click the Open button.

The application appears at the bottom of the Applications list.

Remotely Launching an Application on Student Computers
It can be very difficult to synchronize everyone’s efforts in a computer lab. One group of 
students may be writing an essay in Word while another group works on an Excel 
spreadsheet. Isolated pockets of Internet research may be going on at the same time. Even 
if you’re lucky enough to have a class of very cooperative students, some students may be 
a lot slower than others at closing their current application and opening the application 
you’ve asked them to open. 

With SynchronEyes software, you can save time and aggravation by launching an 
application on every student computer with the click of a button. You can help your students 
switch gears instantly during class, or simply open an application on every student 
computer before class starts, so everyone sits down to the same program.

You can use this feature selectively, too: Launch an application on only one student’s 
computer or on a single group’s computers.

1. Click the Application button in the Views toolbar. 

The Applications view appears.

2. Click the All Students tab if you want the application to launch on every student 
computer.

OR

To add an application to the Applications list

To remotely launch an application on one or more student computers
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Click a Group tab if you want the application to launch on the computers of only a group 
of students.

OR

If you want the application to launch on only one or more individual students, select the 
student(s) in the Student List on the right side of the window.

3. Select an application from the Applications list.

NOTES: 

• Make sure the application you select is installed on the destination computers. If it 
isn’t, you receive a message that the application failed to launch on that student 
computer. 

• Select just one application. If you accidentally click on more than application, just 
click again on the application you don’t want to launch to de-select it.

4. Click the Launch button.

The application immediately opens on the student computer(s).

Capturing an Image of a Student’s Desktop
While you’re monitoring student computer activity in the Thumbnails view, you may want to 
capture an image of one student’s current activity for your records. The Screen Capture 
button lets you take a quick snapshot, creating a JPEG or BMP file of any student’s 
desktop. By default, the resulting graphics files are stored in C:\My Documents. However, 
you can direct the software to store these files anywhere you prefer.

To aid you in record keeping, the file name defaults to the student’s name and the date and 
the time of the screen capture. For example, if you took a screen capture of Oscar’s desktop 
at 8:11 A.M. on April 2nd, the resulting file name would be: 
“Oscar_Apr02_2004_08_11_AM.jpg”. 

TIP You can rapidly capture multiple successive screens and save the 
resulting cluster of files for future reference. When the Save As dialog 
box appears, just type in a new number at the end of the file name. 
Because each new graphics file has a different name (differing only by 
the appended number), you’re in no danger of overwriting previous 
screen captures. 
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1. If you’re not in the Thumbnails view, click the Thumbnails button in the Views toolbar.

2. Click a student thumbnail to select it.

3. Click the Screen Capture button in the toolbar.

The Save As dialog appears.

NOTE: The default file name contains the student’s name followed by the date and the 
time of the screen capture. The default graphics file type is .jpg or .jpeg. If you prefer to 
save the image as a .bmp file, click the drop-down button and select Bitmap file 
(.bmp). You can also save the screen capture as a Portable Networks Graphics 
(.png).

4. Click the Save button.

OR

Click the Save in drop-down arrow and navigate to a different folder. You may also 
want to type a different file name from the default (see the tip on the previous page). 
Then click the Save button.

5. To view the screen capture, browse to your My Documents folder (or the folder you 
selected in step 4) and double-click on the graphics file to open it.

To capture an image of a student desktop as a graphics file
42 Monitoring and Controlling Students



Remotely Logging Off, Shutting Down or Restarting Student 
Computers
Students may leave their computers in a variety of states at the end of the day. Some 
students may perform an orderly log off and shut down; others may just walk away, leaving 
all their open applications running. 

SynchronEyes software lets you shut down (as well as log off or restart) one or more 
student computers, the computers in a group, or all student computers from your 
workstation. The table below summarizes the three shutdown states you can choose.

 

1. Click the Thumbnails button in the Views toolbar. 

The Applications view appears.

2. Click the All Students tab If you want the action to apply to the entire class.

OR

Click a Group tab if you want the action to apply to a particular group of students.

OR

If you want the action to affect one or more students, select the student(s) in the 
Student List on the right side of the window.

Action Description
Log off Ends the student’s current Windows session, leaving 

the computer running. The student’s monitor will 
display the Enter Network Password dialog.

Shut down Ends the student’s current session and shuts down 
Windows so that the computer can be turned off.

Restart Ends the student’s current session, and shuts down 
Windows and then restarts it.

CAUTION If students have not saved their work, they can lose data when you log 
off, shut down or restart their computers. You may want to advise 
students to save their work before you perform any of these actions.

To log off, shut down or restart student computer(s)
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3. Click the Shut Down button.

The Shut Down Student(s) dialog appears. 

4. Select Shut down from the drop-down list to disconnect the student from 
SynchronEyes software and shut down Windows.

OR

Select Log off from the drop-down list to end the student’s current Windows session, 
leaving Windows running and the Enter Network Password dialog box open.

OR

Select Restart from the drop-down list to end the student’s current Windows session 
and restart it. 

5. Click OK. 

TIP Use the Log off option between classes so that all incoming students 
must enter their user names and passwords and then connect to 
SynchronEyes software. With minimal effort on everyone’s part, your 
class thumbnails are updated with the names of the new students 
who’ve just sat down.
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Shutting Down SynchronEyes Software on a Student Computer
At the end of a class, some students may leave without disconnecting from SynchronEyes 
software. Complete the following procedure to shut down SynchronEyes software on a 
student computer.

1. In the File Transfer, Quiz, Chat or Applications views, select the student you want to 
disconnect from the Students list.

OR

In Thumbnails view, select the thumbnail of the student you want to disconnect.

2. Select Disconnect from the Edit menu.

3. Click Yes when the confirmation message appears.

At the student’s workstation, SynchronEyes student-station software automatically 
exits.

Controlling Student Disconnect
You may want to stop your students from disconnecting for a variety of reasons: to ensure 
that the student computers remain up and running from one class to another, or to prevent 
individuals from logging out and avoiding your surveillance.

1. Click the Options menu. 

2. Uncheck Allow Student to Disconnect. 

All student sites lose the ability to disconnect or connect to another Teacher ID. (The 
Connect and Exit commands become unavailable.)

1. Click the Options menu.

2. Check the Allow Student to Disconnect command on the Options menu.

Your students gain the ability to disconnect (the Exit command becomes available). 

To disconnect a student

To disable student disconnection

To enable student disconnection
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When a student disconnects from SynchronEyes software, a large red X is 
superimposed over their thumbnail. See page 26 for information on refreshing your 
Thumbnails view to eliminate these inactive thumbnails.
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Interacting with Students

SynchronEyes software is much more than a surveillance and student-management tool. 
Use it to interact with your students efficiently and effectively.

In this section, you’ll learn how to:

• view and respond to a student question (page 47)

• chat with students (page 49)

• send files to and receive files from students (page 52)

• poll students (page 56)

• broadcast your desktop or a student desktop to the class (page 58)

Viewing a Student’s Question
Questions are an important part of the learning process. However, there’s typically only one 
teacher per classroom, and too many questions at one time can be overwhelming.

SynchronEyes software allows your students to ask questions even when you’re too busy to 
answer them right away. As time becomes available, you can respond to each question. By 
selecting more than one student, you can save even more time by responding to several 
questions at once with a single answer.
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You’ll know instantly when a student has a question: In the Thumbnails view a question icon 
appears over the student’s thumbnail, and in all other views a question icon appears in the 
Students list.

1. Click the Questions button. 

The Questions dialog box appears. 

2. Select one or more questions.

To respond to one or more student questions

Question Icon 

 Question Icon 

Thumbnail View

Students List
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NOTE: Multiple selection in SynchronEyes software is easy. Just click on the names 
you want to select. You don’t need to press the SHIFT or CTRL key. Click again on the 
selected item to clear the selection.

3. To answer the question(s), click the Chat button.

An Answer [Student ID] Question dialog box appears.

OR

To clear the question(s) without responding, click the Clear button.

4. Enter your response in the Message box and press the ENTER key on your keyboard.

On the student’s monitor, a SynchronEyes Student Chat dialog box appears with a new 
tab (the Teacher tab) that contains your response. This chat text is private and only you 
and the student (or students) can view it. If the student responds further, you’ll receive 
their message within the original Answer [Student ID] Question dialog box. 

5. Close the window.

Chatting with Students
The Chat feature helps you keep classroom noise to a minimum. Also, since you can restrict 
your chat to group members, you won’t distract other students unnecessarily. You can also 
save a complete record of the current chat session as a text file. 
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By default, students are not allowed to use the Chat feature. If you allow them, students can 
also initiate chat sessions – either with all their classmates or with fellow members of a 
group. 

Everyone in the class (or the selected group) can view the chat history. However, if you 
need to have a private chat with just one or more students, click the Message button to 
keep the chat text hidden from other students.

1. Click the Chat button on the Views toolbar. 

2. Select the All Students tab or a group tab.

3. Click the Enable button to allow students to participate in the chat session. 

4. Type a message in the text-entry box at the bottom of the window.

5. Press the ENTER key on your keyboard.

All students or all members of the selected group receive your message in the Chat 
History section of the SynchronEyes Student Chat dialog box.

1. Select a student or several students.

NOTE: Multiple selection in SynchronEyes software is easy. Just click on the names 
you want to select. You don’t need to press the SHIFT or CTRL key.

2. Click the Message button. 

A Message dialog box appears.

3. Enter a message in the Message box at the bottom of the dialog box, and then press 
the ENTER key on your keyboard.

Click the Clear button on the toolbar.

The chat history from the current session disappears.

1. Click the Save button on the toolbar. 

To chat with students

To chat privately with selected students

To clear the chat history

To save the current chat session as a text file
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The Save As dialog box appears.

2. Locate a directory in which to save the file.

3. Type a name in the File Name text box.

4. Click the Save button in the Save As dialog box.

Controlling Student Chat
While the Chat feature can enhance classroom collaboration, it can also be a distraction if 
used excessively or at inappropriate times. You can disable the Chat feature in the student-
station software to prevent students from chatting when they should be working.

1. Click the Chat button on the Views toolbar.

2. Click the Enable button (so it doesn’t appear depressed).

On each student’s SynchronEyes Student Chat dialog box, the text-entry area will be 
disabled.

TIP

For easier file management, create separate chat folders for each group 
and enter the current date as part of the file name.

To prevent students from using the Chat feature
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1. Click the Chat button on the Views toolbar.

2. Click the Enable button (so it appears depressed).

Sending Files to and Receiving Files from Students
Reduce paper use in your classroom and improve efficiency by using the File Transfer view 
to distribute handouts and assignments electronically. SynchronEyes software lets you 
send data, video and audio files to your students, who can also send the same types of files 
to you. 

The File Transfer view is divided into a Files Sent section (showing the files you’ve 
transferred to students) and a Files Received section (showing the files you’ve received 
from them). You can open any file in either section of the File Transfer view by double-
clicking it. You can also cancel any file transfer that’s in progress and clear any file from 
either list. 

SynchronEyes software appends the student’s name to the end of any file that they send 
you. For example, if a student named Sheldon transfers Assignment #1.doc to you, the file 
is stored as Assignment #1 - Sheldon.doc.

NOTE: You can send files to all students, a student group or selected students. If a student 
belongs to more than one group, the Files Sent section in both groups will indicate a file 
has been sent to that student.

If you’re sending a file to only one student, you’ll notice the speed of transmission is very 
fast. However, if you send a file to two or more students, you’ll notice a delay. This is 
because SynchronEyes software uses a different protocol to send a file to more than one 
student. In addition, if one student in a group doesn’t receive a file at the same time as the 
others, be patient. This delay is usually because that student’s machine is slower, and, 
rather than reduce the speed of transmission to the rest of the group, SynchronEyes 
software queues a slow computer to receive the file after the others. 

In general, speed of transmission is affected by the following factors:

• the variability of the student computers (e.g., a mix of slow and fast computers)

To enable student chat

Speed of File Transmission
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• the amount of other network traffic (not related to SynchronEyes software)

• the speed of the network

1. Click the File Transfer button on the Views toolbar.

2. Click the All Students tab to send the file to everyone in the class.

OR

Click a group tab to send the file to a group.

OR

Select individual student names to send to just those students.

3. To send a data file, click the Send File button on the toolbar. 

The Send File dialog box appears.

OR

To send a video or audio file, click the Send Media button on the toolbar.

The Send Media File dialog box appears.

4. Click the Look in arrow and browse to the file you want to send. When you finish 
browsing, the file name should appear in the File name box.

To send a file to students
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5. Click the Send button.

The file transfer begins. The name of the file, the recipient name, and the percentage 
that’s been transferred appears in the Files Sent list. When the transfer is complete, the 
file status changes from a percentage to Complete.

1. Select the file that is being transferred in the File list.

2. Click the Cancel button.

No portion of the file is transferred. The file is also removed from the File list.

1. Select the file in the File list.

2. Click the Clear button.

SynchronEyes software removes the file from the File list and from the Submitted 
Student Files folder.

Click the Clear button.

All files in both the Files Sent and Files Received sections disappear from the File 
View.

WARNING If you exit from SynchronEyes teacher-station software while a file 
transfer is in progress, the transmission terminates. This applies to files 
being sent and files being received.

To cancel a file transfer in progress

To clear a file from the File List

To clear all files (both sent and received)
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Specifying File Transfer Preferences
By default, files you receive from your students are stored in C:\My Documents\Submitted 
Student Files, but you can easily specify any other folder. You can also configure the 
software to store received files according to the day they are submitted. Also, rather than 
allowing students to open files at their leisure, you can specify that they open automatically 
on all student desktops. 

1. Select Preferences from the Options menu.

The Preference Settings dialog box appears.

2. Click the File Transfer tab.

To change the default file location for received student files
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3. Click the Custom folder button.

4. Click the Browse button and navigate to another location.

5. Click OK.

1. Select Preferences from the Options menu.

2. Click the File Transfer tab.

3. Select Automatically open files on the students’ computer under Files Sent.

4. Click OK.

1. Select Preferences from the Options menu.

2. Click the File Transfer tab.

3. Select Organize the stored files according to the day they are submitted under 
Files Received.

4. Click OK.

Polling Students
Traditionally, class feedback is obtained by asking for a show of hands, but getting your 
students’ attention in a computer lab can be difficult for you and distracting for your 
students. The Vote feature lets you poll your students in a fast, unobtrusive manner, and 
SynchronEyes software then tallies the results at the bottom of your screen. You can also 
restrict polling to a group, allowing other students to continue working without being 
disturbed.

1. Click the All Students tab or a group tab.

2. Click the Vote button on the toolbar. 

To have the files you send open automatically on student computers

To automatically organize your received files into dated folders

To poll students
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The Vote dialog box appears.

3. Type a yes/no question.

4. Click OK.

In the student software, a Quick Response for Vote dialog box appears.

Students can either accept the default Yes selection or click the No option, and then 
click the Submit button.
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A vote-response icon appears beside each student's name in the Students list, and over 
each thumbnail in the Thumbnails view. The three vote-response icons are shown in 
the table below.

In the Status bar (lower-right area of the window), you’ll see the tallied result of the vote. 

5. To clear the vote (and remove the vote icons), click the Vote button again.

Broadcasting Teacher and Student Desktops
You can broadcast your desktop or a student’s desktop to the entire class or a selected 
group. Before you begin your broadcast, consider whether you want to allow students to 
use their mice and keyboards during the broadcast. If you prefer to block student input to 
other applications during a broadcast, use the default full-screen mode. When you 
broadcast in full-screen mode, students can’t use either their mice or keyboards. 

If you prefer to give students the option of minimizing your broadcast and continuing to work 
on other projects, you must change the broadcast from the default full-screen to windowed 
mode. 

NOTE: While you’re broadcasting, you can annotate over the broadcast desktop with the 
pen tool and view student’s questions.

1. Select Preferences from the Options menu. 

The Preference Settings dialog appears.

2. Select the Broadcast tab.

Icon Response
Student has yet to respond to the vote

Student votes yes

Student votes no

To broadcast in windowed rather than full-screen mode
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3. Select Windowed.

All students have the ability to minimize your broadcast and work in other applications. 
Students cannot, however, close your broadcast window.

 

1. Click the Thumbnails button on the Views toolbar.

The Thumbnails view opens in the All Students tab. To broadcast to all students, leave 
your view as it is.

OR

To broadcast to a group, click a Group tab. 

2. Click the Broadcast button.

A message appears, asking if you want to broadcast your desktop to the class.

3. Click the Yes button.

Your desktop is displayed, in Full Screen view, on all student monitors or the monitors 
of a selected group. During the broadcast, a three-button My Desktop toolbar appears 
in the corner of your screen.

4. To stop the broadcast, click the Close button in upper-right corner of the title bar.

OR

Click the Menu button and select Stop Broadcasting. 

To broadcast your desktop to the class

Click to stop 
broadcasting
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You’ll return to the Thumbnails view. 

1. Click the Thumbnails button on the Views toolbar.

The Thumbnails view will open on the All Students tab. 

2. To broadcast to all students, leave the view as it is. 

OR

To broadcast to an individual group, click a Group tab.

3. Select a student thumbnail. 

4. Click the Broadcast button.

The student desktop displays on student monitors.

5. To stop the broadcast, click the Close button in the floating toolbar.

OR

Click the Menu button in the toolbar and select Stop Broadcasting. You’ll be returned 
to the Thumbnails view.

To show a student’s desktop to the class
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1. While broadcasting a desktop on a SMART Board interactive whiteboard, pick up a pen 
tray stylus.

2. When you’re finished annotating, put the pen tray stylus back in its slot.

Your next contact with the interactive whiteboard makes your annotation disappear.

OR

1. While broadcasting from a computer, click the Pen button on the floating toolbar, and 
click and drag anywhere on the screen.

2. Click the Left-mouse button on the floating toolbar to restore the default left-click 
behavior of your mouse. 

Your annotations disappear from the screen.

1. Click the Menu button on the floating toolbar and select Questions.

The Questions dialog box appears.

2. After viewing the question(s), click the Close button.

NOTES: 

• You must wait until after the broadcast to answer the question.

• Students can only ask questions if you broadcast in windowed rather than full-screen 
mode (see “To broadcast in windowed rather than full-screen mode” on page 58).

To annotate over a desktop broadcast

To view student questions during a broadcast
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Administering Electronic Quizzes

With SynchronEyes software, you may never need to pass out or gather exam papers 
again. Your days of marking quizzes and calculating class averages may also be over. You 
can administer quizzes as often as like because the process no longer adds a significant 
amount of time to your working day.

How SynchronEyes Software Facilitates Quizzes
SynchronEyes software facilitates every aspect of the quiz process – from creating, 
distributing and administering to marking and recording quiz results.   

You create your interactive quiz using a simple template in the Quiz Wizard. This template 
lets you create any combination of multiple choice (randomly or statically ordered), 
matching, ordering, question-and-answer or essay questions. You can even add an image 
to a question, asking your students to identify it or simply providing it as a graphical hint. 

In the Quiz Wizard, all the quizzes you create with your current Teacher ID appear as links 
in the Quiz view, and they’re stored (by default) as .sqz files in the My Documents directory 
(or any other destination folder you choose) of your hard drive. When you select a quiz link 
in the Quiz view, a preview of the quiz, as it will appear on student desktops, appears 
automatically in the bottom half of the Quiz view window.

Distribute the quiz to the class in the Quiz view of SynchronEyes Teacher. With one click 
you can distribute the quiz to all your students or to a single group. If you like, you can 
preview the quiz before you send it by selecting Preview Quiz from the View menu. This 
way, you’ll know exactly what the quiz will look like when it opens on student monitors. 

Before the Quiz: Use a Template to Create a Quiz

Distribute the Quiz with a Mouse Click
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The quiz you distribute to students is an .html file (converted from the .sqz file you created in 
the Quiz Wizard) that’s also stored in the My Documents directory of your hard drive.
 

Unfortunately, the typical layout of a computer lab classroom – rows of monitors squeezed 
into a relatively small space – makes glance-over cheating a temptation. 

To help prevent cheating, the questions in each quiz appear in a different order on each 
student screen. You can change this default setting easily, however, if no such deterrence 
is necessary, or if you just want to use the original question order for every student. 

Students complete the quiz and then click a Submit to Teacher button. If some students 
continue to work on the quiz beyond the allotted time, just press the End Quiz button and all 
quizzes are returned to you immediately. Note that you must also click the End Quiz button 
before you can send out another quiz.

With the exception of essay questions (and any short answer questions that you want to 
mark yourself), SynchronEyes software automatically marks each returned quiz. You’ll also 
receive a Summary of Results that gives you the class average score (and percentage), 
along with individual student scores (and percentages). To view the completed and marked 
quiz, just click on the student name in the Summary of Results.

SynchronEyes software automatically saves all quizzes (.sqz files), class-result summaries 
(.html files) stored with each Teacher ID. By default, all files are stored in the My 
Documents directory of your hard drive, but you can store them anywhere you like. If you 
create a quiz using a different Teacher ID, you can import that quiz into the current Quiz 
view by clicking the Add button and selecting the file.

During the Quiz: Randomized Question Order Helps Prevent Cheating

After the Quiz: Automatic Quiz Collection

Automatic Quiz Marking

Filing Quiz Results

TIP If you prefer to prepare quizzes at home, you can install the Quiz Wizard 
separately on your home computer. Just take the SynchronEyes 
software CD home, load it, and open Setup.exe in the Quiz Wizard 
folder.
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Question Types
Clicking on the Create button in the Quiz view opens the Quiz Wizard, a tool for creating 
interactive, electronic quizzes. With the Quiz Wizard, you can quickly create an interactive 
quiz made up of any of the following question types:

• Multiple choice (random/static answer order)

• Question and answer

• Ordering

• Matching

• Essay 

These question types are discussed in more detail below.

Choose from two types of multiple choice questions: random-answer order and static-
answer order. 

In the random-answer example below, the five possible responses to the question appear in 
a different order in each student’s quiz.

Multiple Choice Questions
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With the static-answer multiple-choice question, you can control the final order of 
alternatives, so students receive the alternatives in the order you specify in the Quiz Wizard.

Question-and-Answer questions can be marked automatically by the software. However, if 
the question requires an answer that’s longer than a word or two, you should consider 
marking them yourself, as automatic marking doesn’t permit a great deal of response 
variability. With automatic marking, you can provide three acceptable variants for student 
responses. 

Question-and-Answer Questions
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In the following example, three acceptable options are given for writing T.S. Eliot (Eliot and 
Thomas Stearns Eliot). Note that if an answer is spelled wrong, the student is marked 
wrong.

In an ordering question, the student is asked to arrange supplied options in the correct 
order. To create an ordering question in the Quiz Wizard, you order the list of options 
correctly. SynchronEyes software then randomly rearranges the answers before sending 
the quiz to your students.

You have the option of using a customized marking scheme for ordering questions. Click 
the Customized Marking button and select to either award one point for each correctly 
ordered item or to award from one to five points for a correctly ordered sequence. If you 
choose the latter, even one misordered item will mean the student receives no marks.

Ordering Questions
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Here’s how an ordering question looks when you create it:

Here’s how the same ordering question appears on a student desktop:

The student clicks the arrow to select numerical order position.
68 Administering Electronic Quizzes



A matching question asks a student to pair a list of items with a corresponding item in 
another list. When you create a matching question with SynchronEyes software, first enter a 
list of items, and then enter the correct match for each item in an adjacent list. 
SynchronEyes software scrambles the matches prior to sending the question to your 
students.

In the following example, a matching question tests the student’s ability to recall specific 
lines and match them to the poems from which they were taken.

For each line, the student then selects the correct poem from a list of options.

Matching Questions
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Sending Questions as Originally Ordered
By default, when you send an exam to students, the questions are distributed randomly, 
appearing in a different order on each student’s screen to prevent glance-over cheating. 

However, you may have good pedagogical reasons for the way you’ve ordered your 
questions. If you’re developing a long, comprehensive final exam, for example, you might 
want to group similar questions together or pace the exam by alternating difficult and easy 
questions. You can easily override the default randomization of questions so they are 
distributed in the precise order in which you created them.

1. Select Preferences from the Option menu.

The Preference Settings dialog appears.

2. Click the Quiz tab.

The Quiz tab appears.

To send questions in their original order
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3. Click Randomize question order for each student to clear the selection.

4. Click OK.

The next quiz you distribute will arrive on each student’s monitor in the same question 
order as it was sent. This setting will remain in effect until you restore the default setting.

Allowing Application Access During a Quiz
By default, quizzes are sent to students in full-screen mode. In full-screen mode, students 
are automatically blocked from accessing other applications (including the Internet) during 
the quiz. 

If you prefer that your students have access to other sources of information, you can 
change this default setting so that quizzes appear in windowed mode. In windowed mode, 
students can access all applications that haven’t been blocked, as well as the Internet (if it 
isn’t blocked). For more information on selectively blocking applications, see page 36. For 
information on blocking Internet access, see page 35. 

1. Select Preferences from the Options menu.

The Preference Settings dialog appears.

2. Click Show quiz in a window to select it. The full-screen option selection is 
automatically cleared.

3. Click OK.

The next quiz you distribute will appear on each student’s monitor in a resizable 
window. Students will also be able to access all applications and the Internet, unless 
you’ve specifically blocked them. This setting remains in effect until you restore the 
default setting.

Withholding Grades
By default, quiz grades are distributed automatically to students very soon after the quiz is 
over. However, you may override this default if you prefer to notify students of their grades 
at another time.

To allow students access to other applications during a quiz
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1. Select Preferences from the Options menu.

The Preference Settings dialog appears.

2. Click Send quiz grades back to student to clear the selection. 

3. Click OK.

Creating a Quiz 
Clicking on the Create Quiz button in the Quiz view opens the Quiz Wizard, a tool for 
quickly creating interactive, electronic quizzes. The quiz template in the Quiz Wizard makes 
it easy to create a quiz of any length. 

Before you create the quiz, you’ll need to either accept the default My Documents storage 
folder or specify any other folder you prefer. However, any quiz you create with your current 
Teacher ID (no matter where it’s stored) appears as a link in the Quiz view for easy access.

NOTE: Although you’ll normally open the Quiz Wizard by clicking on the Create Quiz button 
in the Quiz view, you can also install the Quiz Wizard application separately from 
SynchronEyes software (on your home computer, for example). When installed separately, 
open the Quiz Wizard by double-clicking on QuizWizard.exe. 

1. Click the Quiz button on the Views toolbar.

OR

Select Quiz from the View menu.

The Quiz view appears. 

To withhold quiz grades from students

To create a new quiz in SynchronEyes software

Link to quiz created in the Quiz 
Wizard
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2. Click the Create button. 

The Create Quiz dialog box appears.

3. Accept the default quiz location in My Documents or click the Save in arrow to 
navigate to another folder.

NOTE: You may want to give the quiz a more meaningful name than the default name 
(quiz1, quiz2, quiz3, etc.). To do that, highlight the default name and enter a new name, 
such as “EnglishFinal – June12.sqz”. 

4. Click OK.

The Quiz Wizard window appears. 

5. Enter all the required information in the Quiz Name, Class, Teacher and Instructions 
boxes. The text you enter here appears at the top of the student’s pop-up quiz window.

NOTE: Press the TAB key on your keyboard to navigate to the next box.

6. Type the first question in the Question box.
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7. Select the question type from the Type list. For information on question types, see 
Question Types on page 65.

8. Enter the correct answer and other alternative responses (if required).

9. To add an image, click the Add Image button in the toolbar.

The Insert an Image File dialog box appears.

10. Browse to the image file you want to accompany the question and click the Insert 
button.

NOTE: The maximum image size is 540 x 540 pixels. Images that exceed these 
dimensions will be scaled down to fit that size.

11. When you’ve entered all your questions, click the Save button in the toolbar. 

SynchronEyes software saves the quiz in the previously specified location.

12. Select Exit from the File menu to close the Quiz Wizard.

The Quiz view reappears.

13. Open the quiz you just created by double-clicking on the quiz name in the Quizzes list. 
Click once on the quiz to see a preview of the quiz as it will appear on student desktops.

Quizzes List

TIP
Before you exit the Quiz Wizard, check to see what the quiz will look like 
when it appears on student monitors. Select Preview Quiz from the 
View menu.

Link to quiz
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NOTE: To distribute the quiz to your class, see Sending a Quiz to Students on page 78.

Opening and Importing a Quiz
The Quizzes list contains links to all the quizzes you’ve created using your current Teacher 
ID, no matter where the actual quiz files (.sqz files) happen to be stored in your computer. 

Although the Quizzes list shows only those quizzes associated with the current Teacher ID, 
you can easily import quizzes associated with other Teacher IDs, adding them to the current 
Quizzes list. 

1. Click the Quiz button on the Views toolbar.

2. Double-click on a quiz name under the Quizzes list.

The selected quiz opens in the Quiz Wizard.

1. Click the Quiz button on the Views toolbar.

2. To distribute the imported quiz to a group, select the group tab.

3. Click the Add button. 

The Open dialog box appears.

4. Navigate to the .sqz file you want to add, and click the Open button.

To open a quiz in the Quizzes list

To import a quiz

Click once for a preview of the quiz; 
click twice to open the quiz in the 
Quiz Wizard
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A link to the imported quiz appears at the bottom of the Quizzes list.

Editing a Quiz
You can add and delete questions, as well as cut, copy and paste text using the editing 
tools available in the Quiz Wizard.

Although questions are sent to students in random order by default, you can easily override 
this default (see “Sending Questions as Originally Ordered” on page 70). If you’re 
developing a long, comprehensive final exam, for example, you might want to group similar 
questions together or pace the exam by alternating difficult and easy questions. 
Rearranging questions is easy, so you can create questions as they occur to you and 
arrange them in a more effective order later.

1. Click anywhere in the question you want to move (or in any of its associated answers).

2. To move the question up in the numerical order, click the Move Upward button.

OR

To move the question down in the numerical order, click the Move Downward button.

1. Click anywhere within the question (or in any of its associated answers).

2. To move to the next question, click the Next Question button.

OR

To move to the previous question, click the Previous Question button.

1. Click anywhere within the question (or in any of its associated answers).

TIP By default, all quizzes, student responses and class results are stored in 
the My Documents folder on your hard drive. You may want to create 
and name folders with class names, and then reorganize all the quizzes 
(.sqz files) and student response files (.html files) by moving them into 
their appropriate folders. 

To rearrange questions (and all associated answers)

To navigate within the quiz

To delete a question
76 Administering Electronic Quizzes



2. Click the Delete Question button in the toolbar.

The question disappears and the remaining questions are reordered accordingly.

NOTE: The new question will always precede the selected question.

1. Click anywhere within the question that you want to displace for the new question (or in 
any of its associated answers).

2. Click the New Question button.

A new section appears for you to enter the question. The originally selected question 
appears after the new question.

1. Select the text you want to cut/copy.

NOTE: You can’t select text from more than one text box at a time. For example, you 
can’t simultaneously select text from a question box and text from an answer box.

2. To cut the text, click the Cut button.

OR

To copy the text, click the Copy button.

3. Place the cursor in the location where you want to paste the text.

4. Click the Paste button.

1. Click anywhere within the question (or in any of its associated answers).

2. Click the Add Image button in the toolbar.

The Insert an Image File dialog appears.

3. Browse to the image file you want to add to the question.

NOTE: The maximum image size is 540 x 540 pixels. Images that exceed these 
dimensions will be scaled down to fit that size.

4. Click the Insert button.

To insert a question

To cut/copy and paste text in the Quiz Wizard

To insert an image into a question
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The image contained in the file appears in a preview box in the question template.

NOTE: To delete the image from the question, click the question, and click the Delete 
Image button.

Previewing a Quiz
In the Quiz view, you can preview a quiz at any time just by selecting the quiz link in the 
Quizzes list. An HTML version of the quiz – the same file that will appear on student 
desktops – appears in the bottom half of the Quiz view window. You can use the scroll bar 
to scroll through the entire quiz.

While you’re in the Quiz Wizard, you can also preview the quiz you’re working on to see 
exactly how the quiz will look to the students before you send it.
 

1. Click the Quiz button on the Views toolbar.

2. Click once on a quiz link in the Quizzes list.

A preview of the quiz appears in the bottom half of the Quiz view. Use the scroll bar to 
view the entire quiz. 

1. Select Preview Quiz from the View menu.

The HTML version of the quiz appears exactly as it appears to students.

2. To restore the Quiz Wizard view, select Create/Edit Quiz from the View menu.

Sending a Quiz to Students
When you’re ready to distribute a quiz, click the Start Quiz button and the selected quiz 
automatically opens on all student screens or those of a specified group. 

To preview a quiz in Quiz View

To preview a quiz in the Quiz Wizard

TIP
You can also preview each quiz in the Quiz view of SynchronEyes 
Teacher. Just select the quiz from the Quizzes List, and a preview of 
that quiz appears in the bottom half of the Quiz view window.
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1. To send the quiz to a specific group of students, click the Group tab. (By default, the 
quiz is sent to all students.)

2. Select the quiz from the Quizzes list.

OR

If the quiz doesn’t appear in the Quizzes list, click the Add Quiz button to browse to it. 

3. Click the Start Quiz button.

The quiz appears on each student screen, over top of any open application.

In the Quiz view, an HTML file called Summary of Results appears below the quiz file. 
As students submit their responses, this file is updated with each student’s completed 
quiz and score, together with a summary of the class results.

4. Ask your students to select their answers and click the Submit to Teacher button when 
they finish the quiz.

OR

Click the End Quiz button to have all quizzes immediately sent to you (see Collecting 
Student Quizzes immediately below). 

5. Double-click on the student’s name in the Summary of Results to view the scored 
student quiz.

Although you can access each file submitted by your students and the Summary of 
Results file from the links in the Quiz view, all files are stored in the same location as 
the quiz file. Each Response folder clearly indicates the quiz name, as well as the time 
and date of the quiz. 

6. If you didn’t click the End Quiz button to collect the quiz in step 4, click the End Quiz 
button now. This reactivates the Start Quiz button so you can send out another quiz.

To start a quiz

TIP You might want to locate the Response folder on the network so 
students can open and review their marked quizzes without your direct 
involvement. Open Explorer, navigate to My Documents, locate and 
copy the Response folder, and then paste it to a network location. 
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Collecting Student Quizzes
Asking students to finish and submit a quiz to you by a certain time doesn’t always work. 
Some students will always keep working on a quiz beyond the deadline. Put an end to 
collection frustration by recalling all student quizzes with the click of a button. 

In the Quiz view, click the End Quiz button.

All student quizzes that have not already been submitted will be sent to you.

Importing a Quiz from Version 3.0 of SynchronEyes Software
You can import a quiz you created in version 3.0 of SynchronEyes software using the 
Import command in the Quiz Wizard’s File menu.

NOTE: You can open a version 4.0 quiz as you would a version 5.0 quiz. The Import 
command is solely for importing version 3.0 quizzes.

1. In the Quiz Wizard, select Import 3.0 Quiz from the File menu.

An Open dialog appears.

2. Navigate to the .sqz file you want to import.

3. Click OK.

To collect the quizzes

To import a quiz from a previous version of SynchronEyes software
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The Student Interface

This section describes the visible student interface. To observe your students 
surreptitiously, set SynchronEyes student-station software to run in hidden mode either 
when you’re installing the program or anytime afterwards (if you’ve installed the Student 
Configuration Wizard). SynchronEyes software will run invisibly, without any visual 
indication of its presence on the students’ computers. 

For information on switching SynchronEyes student-station software from visible to hidden 
mode after installation, turn to page 9.

Student System Tray Icons
From the student’s point of view, SynchronEyes software keeps a very low profile – even in 
visible mode. An icon in the system tray (located at the right side of the task bar) is the only 
indication to students that their actions are being observed. 

The student can access the full range of program functions by clicking on the 
SynchronEyes icon, including:

• logging off from SynchronEyes software (page 89)

• joining a group (page 89)

• asking the teacher a question (page 91)

• casting a vote (page 91)

• chatting with the teacher or other students (page 92)

• submitting responses to a quiz (page 93)

• viewing files sent by the teacher (page 93)

• submitting a file to the teacher (page 94)

These functions are available from the Student Menu or the movable Student toolbar. 

Click to access SynchronEyes student software
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Click once on the SynchronEyes icon to view the Student menu. This menu disappears 
after you select a command. If the student uses the program infrequently, this is a useful 
and unobtrusive tool for accessing commands.

Student Menu

Students can access the Student toolbar by double-clicking the SynchronEyes icon or by 
selecting the Open command on the Student menu. This toolbar is portable and remains 
open on students’ desktops after they’ve click a button, so it’s the best choice if students 
frequently use the software to chat or ask questions, etc. 

Student Toolbar

The Student Menu

The Student Toolbar
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To move the toolbar, click the side bar and drag it anywhere on the student desktop. 

You can also minimize the Student toolbar by double-clicking on the side bar. Double-click 
again on the side bar to restore the original full toolbar. 

Moving and Minimizing the Student Toolbar

Double-click to 
minimize

Double-click to 
restore

Click and drag to 
move the toolbar
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The SynchronEyes icon changes to indicate the current status of the student. The table 
below summarizes the three variations of the SynchronEyes icon. 

System Tray Icons

Student Status System Tray Icon
Attempting to connect to the teacher. This 
icon also appears if the teacher has not yet 
opened SynchronEyes software.

Successfully connected to the teacher and 
subject to teacher monitoring. The student 
can send a question, chat (if enabled), cast 
a vote, answer quiz questions and log out (if 
enabled).

Appears when teacher is controlling 
student.
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Using the Student Software

Although students have a limited range of capabilities with SynchronEyes software, you’ll 
want to show them how to perform the following simple tasks:

• Open the software (page 85)

• Log on (page 86)

• Change the teacher connection (page 88)

• Log off (page 89)

• Join a group (page 89)

• Ask the teacher a question (page 91)

• Cast a vote (page 91)

• Chat (page 92)

• Submit a quiz (page 93)

• Send a file to the teacher (page 94)

NOTE: All the introductions in this section are written from the teacher’s perspective, but all 
the step-by-step procedures are written from the student’s point of view, so you can 
distribute the procedures to your students without modification.

Opening the Student Software
If the student software is not running in Hidden mode (see page 8), students can open it and 
use it to ask questions, chat, and respond to polls.

1. Double-click the SynchronEyes Student icon on the desktop. 

To open the student software
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A connection with the last Teacher ID to which you were connected is automatically 
initiated. 

2. Click the Connect button in the Connect to Teacher dialog box to complete the 
connection.

NOTE: If the teacher hasn’t opened SynchronEyes teacher-station software, you may 
need to wait a few minutes. As soon as that Teacher ID is active on the network, the 
connection takes place automatically. 

Logging On to the Student Software
By default, students don’t need to log on to the student software with their own name 
because the user account associated with their computer automatically appears as the 
student name under the thumbnail.

However, since many different classes use a single set of computer-lab resources, we’ve 
also made it easy for students to log on and identify themselves without reopening 
SynchronEyes software. In this way, the student software can run throughout the day, with 
different students occupying each workstation, and your Thumbnails view will always show 
the name of the current student. 

If you want your students to log on with their own name, you can configure this option in the 
student software during or after installation. See page 9 for information on reconfiguring the 
student software to enable student log on. Ask your students in each class to log on when 
they first sit down at the computer. They’ll need to do this only once; in the future, they can 
simply scroll to their name at the beginning of each class period.

The following procedure shows students how to log on to SynchronEyes software.
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1. Double-click the SynchronEyes icon.

2. Click the Connect button.

The Connect to Teacher dialog box appears.

3. If this is the first time you’ve logged on to SynchronEyes software:

Type your name in the Your Name box.

OR

If you’ve logged on previously:

Click the Your Name arrow and select your name from the list. 

NOTE: SynchronEyes software stores the last ten student names entered and/or 
activated on this computer. If you haven’t used this computer for a while, you may need 
to enter your name again.

4. The Teacher ID to which you last connected should appear in the Teacher ID box. If it 
doesn’t appear, click the arrow and select the correct Teacher ID.

To log on to the student software

Click to access SynchronEyes student-station software
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NOTE: If you can’t find the correct Teacher ID in the Teacher ID list, click the Cancel 
button and wait a minute. Your teacher may not have connected to the network prior to 
your logon attempt. After your teacher connects, try logging on again.

5. Click the Connect button.

Your name appears under the thumbnail associated with your computer in your 
teacher’s Thumbnails view.

Connecting to a Different Teacher ID
If you change your Teacher ID while your students are working, a message appears on their 
desktops asking if they’d like to switch to the new teacher. Your students can click the Yes 
button to automatically connect to the new Teacher ID. 

Students can also manually connect to a different Teacher ID, as shown below.

1. Double-click the SynchronEyes icon in the system tray.

2. Click the Connect button.

The Connect to Teacher dialog box appears.

3. Select a different Teacher ID from the Teacher ID list.

4. Click the Connect button.

To connect to a different Teacher ID
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Logging Off of SynchronEyes Student-Station Software
Students can only log off from SynchronEyes student-station software if you allow them to. 
By default, students are not permitted to disconnect from SynchronEyes software.

You may want to stop your students from logging off for any number of reasons. For 
example, you may find they’re logging off to play games or surf the Internet unobserved, or 
you may simply want to keep the students’ machines continuously connected throughout 
the day. 

If you disable your students’ ability to disconnect, the Exit command is deactivated on their 
computers. Turn to page 45 for instructions on controlling your students’ ability to log off 
from SynchronEyes software.

1. Click once on the SynchronEyes icon in the System Tray.

The Student menu appears. 

2. Select Exit.

In the teacher’s Thumbnails view, a large red X appears over your desktop thumbnail.

Joining and Withdrawing from a Group
Only you can create a student group, and students can only join (or leave) a group with your 
permission. You may want to keep some groups closed to new members.

1. Click the SynchronEyes icon in the system tray, and select Group. 

To log off from SynchronEyes student-station software

To join a group
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The Join Groups dialog box appears.

2. Select the group you want to join in the New Groups list.

3. Click the Join button.

The selected group moves from the New Groups list to the Joined Groups list.

4. Click OK.

The new group appears as a tab in your Chat dialog box.

1. Double-click the SynchronEyes icon in the system tray and click the Group button.

The Join Groups dialog box appears.

2. Select the group you want to withdraw from in the Joined Groups list.

3. Click the Withdraw button.

To withdraw from a group
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The selected group moves from the Joined Groups list to the New Groups list.

4. Click OK.

Asking the Teacher a Question
If you’re busy, students often have difficulty getting your attention when they have a 
question. SynchronEyes software offers an easy way for students to ask questions without 
the frustration of not being noticed.

1. Double-click the SynchronEyes icon in the system tray and click the Questions 
button.

The Ask Question dialog box appears.

2. Type your question in the My question is text box.

3. Click the Submit button. 

When your teacher responds, a chat dialog box automatically appears, open at the 
Teacher tab. You can now engage in a direct and private conversation with your 
teacher.

Casting a Vote
You can ask your students a simple yes/no question at any time. Responses are 
immediately displayed on your screen.

To ask the teacher a question
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1. When a Quick Response for Vote dialog box appears, accept the default Yes option or 
click No.

2. Click the Submit button.

Chatting with the Teacher and Other Students
If you allow it, any student can initiate a chat session with other students. However, you may 
want to let them know that you can see all chat messages, regardless of whether they’re 
directed to a specific group or the entire class.

NOTE: Unlike the teacher, students cannot save a record of their chat session as a text file.

1. Double-click the SynchronEyes icon in the system tray, and click the Chat button.

The SynchronEyes Student Chat dialog box opens at the All Students tab.

2. To chat with an individual group (rather than the entire class), click a Group tab.

3. Type your message in the My Message box.

4. Press the ENTER key on the keyboard.

Your message is sent to all students (plus your teacher) or to a specific group (plus your 
teacher). 

To cast a vote

To send chat messages
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5. To close the SynchronEyes Student Chat dialog box, click the Close button (located in 
the upper-right corner).

Completing a Quiz
When you distribute a quiz to your students, a quiz window automatically appears on their 
desktops, over top of any applications that may be open.

Students must click one option or type a short answer or essay to indicate their response.

1. When a quiz appears on your screen, click the correct answer or type a response for 
each question.

2. Click the Submit button.

SynchronEyes software sends your completed quiz to your teacher.

NOTE: If you don’t submit your quiz in a timely fashion, your teacher can collect all 
quizzes, regardless of whether you’ve finished all the questions.

Receiving Files from the Teacher 
You can send files to your students that automatically open on their desktops, or you can 
allow your students to open them at their convenience. In this situation, your students can 
view files they’ve received by clicking the Received Files button on the Student toolbar. 
Windows Explorer then automatically opens at the directory where the files are stored.

1. Double-click the SynchronEyes icon in the system tray and click the Received Files 
button.

Windows Explorer opens at the directory specified by your teacher for submitted files 
(the default location is C:\My Documents\Shared Files).

To submit a quiz response

To view the files sent by your teacher

TIP All files submitted by a teacher to students will have the teacher’s name 
(as derived from the Teacher ID) as the end of the file name. For 
example, if your teacher’s name is Mr. Jordan, you’ll find all file names in 
the Shared Files folder conclude with “- Mr. Jordan”. 
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2. Open the new files in the directory.

Sending Files to the Teacher
You may ask your students for their completed assignments using SynchronEyes student-
station software. Students simply navigate to the file and click the Submit button.

1. Double-click the SynchronEyes icon in the system tray and click the Submit File 
button.

The Submit File dialog box appears.

2. Click the arrow beside Look in and navigate to the directory that contains the file you 
want to send.

3. Select this file.

4. Click the Submit button.

SynchronEyes software sends the file to your teacher.

To send a file to your teacher
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Customer Support

SMART’s Technical Support team welcomes your call. However, you may want to contact 
your local reseller first if you experience problems with any SMART product. SMART’s 
resellers can readily provide you with quick advice, so you can start enjoying the benefits of 
the SynchronEyes software without delay.

Contacting SMART Technical Support
All SMART software includes free telephone, fax and e-mail support. 

Telephone: toll-free at 1.866.518.6791 (Canada/U.S.) or +1.403.228.5940 
(all other countries)
(Available 7 a.m. –  6 p.m. Mountain time from Monday to Friday)

Fax: +1.403.806.1256

E-mail: support@smarttech.com

Website: www.smarttech.com

Please provide us with information about when you purchased the product, the reseller’s 
name, the version of your operating system.

General Inquiries
Switchboard: toll-free at 1.888.42.SMART (Canada/U.S.) or +1.403.245.0333 

(all other countries)

Fax: +1.403.806.1256

E-mail: info@smarttech.com

Our Address:SMART Technologies Inc.
Suite 300, 1207 - 11th Avenue SW
Calgary, AB   CANADA   T3C 0M5

Registration
Product registration is available from www.smarttech.com/registration. To facilitate user 
support and to receive news and updates, complete this form.
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Sending Feedback
You can help us improve our documentation by e-mailing your comments to  
TechnicalDocumentation@smarttech.com. We’d love hear from you!

Obtaining More Information for Your Product
Visit www.smarttech.com\support to:

• download pdf copies of our user guides, installation instructions and more

• read technical bulletins, FAQs and tips 

• troubleshoot a problem

• explore our resource centers to learn about conferencing and room control systems
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Appendix: License Agreement

License Agreement for SynchronEyes Software 
Please read this License Agreement carefully. This is a legal agreement between your 
company (the “Company”) and SMART Technologies Inc. (“SMART”) for SynchronEyes 
computer-lab instruction software (the “Software”).

This License Agreement provides important information concerning the Software, provides 
the Company with a non-exclusive and non-transferable license to install and use the 
Software and contains warranty and liability information. By first installing and using the 
Software, you, on behalf of the Company, are accepting the Software and are agreeing to 
become bound by the terms of this License Agreement. By so installing and using, you 
acknowledge that you have the authority to bind the Company to the terms of this License 
Agreement. If you do not have such authority or you, on behalf of the Company, do not 
otherwise agree to be bound by the terms of this License Agreement, do not install or use 
the Software.

1.   Grant of License

Subject to payment of the applicable license fees, SMART grants the Company a non-
exclusive, non-transferable license to install and use the Software and accompanying 
documentation as follows:

(a) the Company may install and use the Software on one (1) teacher-station desktop 
computer and an unlimited number of student-station desktop computers;

(b) the Company may transfer the Software to/from one teacher-station desktop computer 
to another teacher-station desktop computer provided that it is removed from the teacher-
station desktop computer from which it is transferred;

(c) any copying of the Software for teacher-station desktop computers is prohibited unless 
additional Software licenses are purchased by the Company; and

(d) the Company may copy the documentation, without change, as necessary to fully utilize 
the Software, provided the copies contain all of the original proprietary notices.

Any attempt by the Company to install or use the Software on teacher station desktop 
computers in excess of the number actually purchased and licensed by the Company is a 
breach of this Agreement. 
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2.   Restrictions

The Company may not decompile, reverse engineer, disassemble, or otherwise reduce the 
Software to a human-perceivable form. The Company may not modify, rent, resell for profit, 
distribute or create derivative works based upon the Software.

3.   Ownership and Proprietary Markings

The Company agrees that nothing in this License Agreement conveys to the Company any 
right, title or interest in the Software including all intellectual property rights created by or 
arising out of the performance of this License Agreement and the intangible concepts, 
knowledge, ideas, information, methodologies and know-how contained in and given effect 
through the Software.

SMART’s logos, product names, the Software manuals, documentation and other support 
materials are either copyrighted, trademarked, constitute valuable trade secrets (whether or 
not any of them may be copyrighted or trademarked) or are otherwise proprietary to 
SMART. The Company agrees not to remove any product identification or notices of the 
proprietary restrictions from SMART’s products.

4.   Technical Support

Technical support will be provided by SMART free of charge for any issues that arise during 
initial installation of the Software. Any technical support beyond initial installation will be 
provided by SMART in accordance with SMART’s software support policies and 
supplementary agreements, if any, at applicable fees. 

5.   Termination

This License Agreement is effective until terminated. The Company may terminate this 
License Agreement at any time by destroying the Software in the Company’s possession. 
This License Agreement will also immediately terminate if, in SMART's sole opinion, the 
Company has failed to comply with any term or condition of this License Agreement. In the 
event of such termination, the Company agrees to certify in writing to SMART that the 
Software (together with any and all copies) has been destroyed or, alternatively, has been 
returned to SMART.

6.   Software Selection for Intended Results

The Company, and not SMART, assumes responsibility for (i) the selection of the Software 
to achieve its intended results; and (ii) the installation, use and results obtained from the 
Software.
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7.   Disclaimer of Warranties

If the Software proves defective, SMART will replace the Software for up to ninety (90) days 
from the date of purchase; otherwise, the Company assumes the entire cost of all 
necessary servicing, repair or correction of the Software. 

Except as provided above, the Software is provided “as is” without warranty of any kind, 
either expressed or implied, including, but not limited to the implied warranties of 
merchantability and fitness for a particular purpose. SMART does not warrant that the 
Software will meet the Company’s requirements or that the operation of the Software will be 
uninterrupted or error free. The entire risk as to the performance of the Software is with the 
Company. Some jurisdictions do not allow the exclusion of implied warranties, so the above 
exclusion may not apply to the Company. This warranty gives specific legal rights and the 
Company may have other rights that vary from jurisdiction to jurisdiction. 

8.   Limitation of Damages

SMART SHALL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES OR LOSS (INCLUDING DAMAGES FOR LOSS OF 
BUSINESS, LOSS OF PROFITS, OR THE LIKE), WHETHER BASED ON BREACH OF 
CONTRACT, TORT (INCLUDING NEGLIGENCE), PRODUCT LIABILITY OR 
OTHERWISE, EVEN IF SMART OR ITS REPRESENTATIVES HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE 
LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THIS LIMITATION OR EXCLUSION MAY NOT APPLY TO THE 
COMPANY. The limited warranty, exclusive remedies and limited liability set forth above 
are fundamental elements of the basis of the bargain between SMART and the Company. 
The Company agrees that SMART would not be able to provide the Software on an 
economic basis without such limitations.

9.   General

This License Agreement shall be governed exclusively by the internal laws of the Province 
of Alberta, Canada. 

If the Company has any questions concerning this License Agreement, or if the Company 
desires to contact SMART for any reason, please write:

SMART Technologies Inc., 
Suite 300, 1207 - 11th Avenue SW, 
Calgary, Alberta CANADA T3C 0M5
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Go from chaos to control without leaving your desk

SynchronEyes software gives you the power to manage your classroom,

guide learning and interact with students – all from your computer. 

Minimize distractions and maximize learning with teacher-friendly 

features. View student screens from your desktop, chat with individuals

or groups, lock computers, control computers remotely and block

games and the Internet. Create polls and quizzes, and the software

automatically tallies the results. Broadcast any screen to the entire 

class – all without leaving your desk.

Because you can't be everywhere at once, you need another way to

keep students on task. Whether you're in a small or large computer lab,

SynchronEyes software helps you stay in touch with your students and

enrich their learning environment.

Computer-Lab Instruction Software
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